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What is Banner?  
Banner Student brings together administrative and academic functions to make it easier to 

manage data while giving students and faculty secure online access to the information 

they need. This is a product of SunGard Higher Education It may be accessed two 

different ways.  

 

INB – Internet Native Banner is the database where student information is entered.  

SSB – Self Service Banner (myTSU) used by students, advisors, staff, and faculty.  

Changes made in myTSU update INB and vice-versa. Internet Explorer will be the 

browser of choice at TSU.  

  

Information from Banner Student training documents and resources has been extracted in 

an effort to offer a concise overview of navigating in Banner
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Logging into Internet Native Banner (INB) 

Access TSU homepage Go to: http://phonon.tnstate.edu:7201 

 

This is the login menu.  You must select the correct Banner database to login 

successfully.  Instructions on how to log into Banner will be given by your instructor. 

This is the Login menu: Click on Internet Native Banner (INB) 

 

http://phonon.tnstate.edu:7201/


 4 

 

This is the logon dialog box. Enter the username and password given by your instructor.  

Click on Connect. 
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Menu  
The Main Menu provides an overview of the menus, forms, and jobs on Banner. Use the 

Main Menu to navigate through Banner.  

 
Menu Part             Description 

Menu Bar              Offers a variety of options for navigating within Banner. 

 

Object Search        Access a form, job, or Quick Flow if you know part of its name, 

                               Description or type. 

 

Toolbar                  Set of icons that represent shortcuts for performing common functions 

                               From the main menu 

 

Auto Hint/Status      Describes the Field where the cursor is located 

 Line 

                                 Displays error and processing Messages 

 

                                 Explains the purpose of the field, what can be done next or how to 

                                 Access another window or form 

 

Hierarchical Tree     Access forms through the main menu hierarchical tree 

Menu Structure        structure
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Menus - How to Access Forms  
 1. Hierarchical menu  

 2. Go To… Field from Main Menu  

 3. Go To… Field accessed by <F5> function from a form  

 4. Options Menu from within a form  

 5. List of forms accessed during current Banner Session stored in the File Menu  

 6. Direct Access Form  

 7. Site Map  

 

Hierarchical Menu  

When accessing forms from the Main Menu they are displayed as a hierarchy. You can 

expand and collapse content by clicking on the folders. If you do not have permission to 

access certain forms on a product menu then you will not see those forms. Therefore, you 

will only see the product menu and the submenus under it.  

 1. Find the product area that you wish to access  

 2. Double click on the closed folder next to the product to expand the menu  

 3. Double click the form you would like to access or expand an area further by 

clicking the closed folder  
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Main Menu ‘Go To…’ Field or File/Direct Access  

You can access a form from the Go To… field from the Main Menu, if you know the 7-

character code of the form you wish to access. You may also use the up and down arrow 

keys in the Go To… field to access forms you have previously opened during your 

current Banner session. Another option is to select Direct Access from the file menu.  

What is a form?  
A form is an online document where you can enter and look up information in your 

database. It is comparable to a screen in SIS+.  
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Parts of a form 

 
Part  Description  

Title Bar  May display the form’s descriptive name, the seven-

character ID name, the software version number and the 

database name.  

Search Icon  Calls up the set-up form that contains the pre-entered data 

for you to select an ID.  

Key Block  Contains information that determines what is entered or 

displayed on the remainder of the form.  

Information 

Block  

Displays data about the information entered in the Key 

Block. Area where you enter information prior to 

updating a record.  

Field  Area on a form where you can enter, query, change, and 

display specific information.  

Pull-down 

List  

Used to select a field value from a list of pre-defined 

values. A down arrow in the right side of the field 

indicates that the field has a pull-down list.  

Tabs  Tabs are used to arrange information in a meaningful way, and allow 

you to navigate easily between groups or blocks of information.  

Title 

Bar 

Field 

Search 

Icon Information 

Block 

Pull-down 

list 



 9 

What does the form name mean?  
Every form has an abbreviated 7 character form name. Most of the time, forms are 

referred to by this 7 character form name.  
 • Position 1 – Identifies the Banner product owning the form, report, process or table.  

 o G = General  

 o S = Student  

 • Position 2 – Identifies the application module owning the form, report, process or table. Is unique 

to the product identified in position 1  

 o G = General  

 E = Event Management  

 J = Job Submission  

 L = Letter Generation  

 O= Overall  

 P = Purge  

 S = Security  

 T = Validation form/table  

 U = Utility  

 o S = Student  

 A = Admissions  

 C = Catalog  

 E = Support Services  

 F = Registration/Fee Assessment  

 G = General Student  

 H = Grades/Academic History  

 I = Faculty Load  

 L = Location Management  

 M = CAPP  

 O= Overall  

 P = Person  

 R = Recruiting  

 S = Schedule  

 T = Validation form/table  

 • Position 3 – Identifies the type of form, report, process or table.  

 o A = Application  

 o B = Base Table  

 o I – Inquire  

 o P = Process  

 o R – Rule Table, Repeating Table, Report or Process  

 o V = Validation  

 o M = Maintenance  

 • Position 4, 5, 6, 7 – Identifies a unique four-character code for the form, report, process or table.  

 o ***IDEN = Identification  

 o ***PINC = Position Incumbent  

 o ***STDN = Student Relation  

 o ***PERS = Person
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Form Components  
All Banner Forms are made up of three components: Records, Fields, and Blocks.  

A block is a section of a form or window that contains related information. If a form or window contains 

more than one block, each block (except the key block) may be enclosed in a beveled box. There are two 

types of blocks, a Key Block and an Information Block.  

 • Key Block  

 o Where you start on a form  

 o Every form has a Key Block  

 o A unique code is entered such as an ID number, term code or document number.  

 o Lets Banner know what piece of information you want to retrieve  

 o The rest of the information on the form will refer to the information that you enter on 

the Key Block.  

 • Information Block  

 o Section that contains related information to what was entered in the Key block  

 o A line may separate each Information block on the form  

 

  

 
 
The Record Counter displays number of records viewed and the number of total records.  A question mark 

in the status line signifies that there are more records, but you haven’t gotten to the last one, so the 

computer doesn’t know how many there are yet.

Next 

Block 

Previous 

Block 



 11 

Wildcards (Searching for items in a database)  
A wildcard is a special character that represents one or more other characters. Use 

wildcard symbols % and _ in the search criteria.  

 • % (percent sign) represents any number of characters  

 • _ (underscore) represents one occurrence of a character  

“ma” is used as an example. The wildcard symbols can be used with any combination of 

latter in any order.  

To get these results…  Enter these criteria…  

All entries that contain ma  %ma%  

All entries that begin with ma  ma%  

All entries that end with ma  %ma  

All entries that have m as a second character  _m%  

 
Options Menu 

 

Forms can also be accessed from the Options Menu within a form.  When you are in most forms Banner 

lists related forms in the Options Menu.  You may access these forms by choosing them from the Options 

Menu and when you close out of the chosen form you will be taken back to the original, or “calling” form. 
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Setting up My Banner  

The following forms are used to create, change and copy My Banner.  

Form  Code  Purpose  

Personal Menu Maintenance  GUAPMNU  Create and change your 

personal menu  

Personal Menu Maintenance 

Menu and Copy  

GUTPMNU  Copy your personal menu to 

or from another user  

Menu Bar Overview  
The menu bar is located at the top of the menu on all forms. It offers a variety of options 

for navigating within Banner. The menu bar is accessible anytime except when a dialog 

box, alert box, or list of values (LOV) is displayed on the screen  

The menu bar consists of several pull-down menus
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Pull-Down Menus  

There are nine pull-down menus on the menu bar, each with a variety of selections. A dimmed option on a 

pull-down menu means that the option is disabled.  

File Menu  

Option  Toolbar 

Icon  

Keyboard Shortcut  Purpose  

Direct Access  F5  Accesses the Direct Access From – GUAPARM  

Object Search  Accesses the Ojbect Search Form – GUIOBJS to locate a form, 

job, or Quick Flow if you know part of its name, description, or 

type  

Quick Flow  Displays the Quick Flow Form (GUAQFLW) which is used to 

access a Quick Flow  

Select  Shift-F3  Returns you to the calling form and enters the 

selected value into the field that called the form  

Rollback  Shift-F7  Action depends on what type of form is currently 

used.  

Form  

Action  
Application and Inquiry  

Clears all information (except Key information) and 

returns you to the first enterable field in the Key 

Block  

Validation  

Returns you to the first enterable filed on the form  

Query  

Returns you to the first enterable filed on the calling 

form  

Save  F10  Saves all changes entered since the last time you 

saved  

Refresh  Clears the message line; redraws the screen  

Print  Prints the current window; inputs the date and time in the title bar  

Exit  Actions vary.  

If selected from…  

Then you…  
A form  

Exit that form  

The main menu  

Exit form Banner  

Query mode  

Cancel the query  

Exit Quick Flow  Exits you from your Quick Flow  

Preferences  Displays the Personal Preferences Maintenance Form 

(GUAUPRF) which is used to customize Banner for 

individual users  
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Edit Menu  

Option  Toolbar 

Icon  

Keyboard Shortcut  Purpose  

Cut  Ctrl-X  Cuts selected text and places it o the clipboard  

Copy  Ctrl-C  Copies selected text and places it on the clipboard 

Paste  Ctrl-V  Pastes text from the clipboard to the cursor 

location  

Edit  Displays the editor window which is used to enter and update 

text  

 

Options Menu  

The Options Menu varies from form to form. Some take you to other blocks and windows within the 

current form, other options take you outside the current from. The Options menu as well as valid File 

menu options may be accessed at any time by right clicking on a blank section of any form.  

Block Menu  

The Block Menu enables you to move from one block area to another within a form.  

Option  Toolbar 

Icon  

Keyboard Shortcut  Purpose  

Previous  Ctrl-Page Up  Moves cursor to the previous block that has at least one 

enterable field  

Next  Ctrl-Page 

Down  

Moves cursor to the next block that has at least one 

enterable field  

Clear  F7  Clears all information in the current block. Also known 

as Enter Query. Puts the form in Query Mode  

 

Item Menu  

The Item Menu enables you to move from one field to another and clear and duplicate data within a form.  

Option  Toolbar 

Icon  

Keyboard Shortcut  Purpose  

Previous  Shift-Tab  Moves the cursor to the previous enterable field  

Next  Tab  Moves the cursor to the next enterable field  

Clear  Clears all information from the current field on your 

display. Does not remove information from any 

records or tables.  

Duplicate  Duplicates the contents of the same field in the 

previous record and copies it into the new record. Used 

in blank row of a repeating record  
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Record Menu  

The Record Menu allows you to work with records within a form.  

Option  Toolbar 

Icon  

Keyboard Shortcut  Purpose  

Previous  Up Arrow  Moves cursor to the enterable field in the previous record  

Next  Down 

Arrow  

Moves cursor to the first enterable field in the next record 

of the current block. If the cursor is in the last record, a 

new record is created  

Scroll Up  Page Up  Scrolls up the list of repeating records.  

Scroll Down  Page Down  Scrolls down the list of repeating records.  

Clear  Clears all information from the display of the current record  

Remove  Shift F6  Removes all information for the current record. When 

you save the record is permanently deleted  

Insert  F6  Inserts a new blank record in the existing records  

Duplicate  F4  Duplicates the content of all fields in a record and copies 

them into a new record  

Lock  Temporarily locks the contents of the record so no other Banner 

user can update it.  

Note: Save, Rollback, then Exit releases the lock.  

Query Menu  

The Query Menu contains the functions used to search for information in the database based on specific 

criteria.  

Option  Toolbar 

Icon  

Keyboard Shortcut  Purpose  

Enter  F7  Puts the form into Query mode so you can enter search 

criteria to see information already in the database  

Execute  F8  Searches the database and displays records that match 

your search criteria  

Last Criteria  F7 twice  Enters the criteria from your last search (enabled only 

when you are in Query Mode)  

Cancel  Ctrl-Q  Cancels the Query and takes the form out of Query 

Mode  

Count Hits  Counts the number of records that match the search criteria and 

displays that number on the Auto Hint Line  
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Quick Reference Guide to Banner Keyboard Commands 

 
 

  

Function   Menu Option  Keyboard  

Next Record  Record/Next  ↓  

   

Previous Record  Record/Previous  ↑  

Delete Record  Record/Remove  Shift+[F6]  

Insert Record  Record/Insert  [F6]  

Next Block  Block/Next  Ctrl+Page Down  

Previous Block  Block/Previous  Ctrl+Page Up  

Enter Query  Query/Enter  [F7]  

Execute Query  Query/Execute  [F8]  

Cancel Query  Query/Cancel  Ctrl+Q  

Rollback  File/Rollback  Shift+[F7]  

Save (Commit)  File/Save  [F10]  

Next Field  Item/Next  Tab  

Previous Field  Item/Previous  Shift+Tab  

Exit  File/Exit  Ctrl+Q  
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Guidelines for Searching in Banner  
In the ID field in the Key Block of a form, press F4 or click on down arrow for Option 

List to access Person Search (SOAIDEN) or Alternate ID Search (GUIALTI) See 

snapshot below. 
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SOAIDEN (Person Search Form)  
If you select SOAIDEN, enter Last Name and in the First Name you may enter the first 

letter with the wildcard (%). For example:  
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You may search or execute this query by:  

 1. Press F8  

 2. From the toolbar Query/Execute  

 3. Select the Execute Query icon between the question mark and X on the toolbar.  

 

The format for all person searches is: Last name, First Name  

Examples:  

 1. Smith, J% --This will return all ID’s with last names of “Smith”and first names 

beginning with “J”  

 

 2. Mag%, P% --This will return all ID’s with last names staring with “Mag” and 

first names starting with “P”  

 

 3. %, Barbara --This will return all ID’s with the first name “Barbara”  

 

 4. M%vish --This will return all ID’s with the name having a first initial “M”, 

ending with “vish” and having anything in between  

 

 5. Smith, Carol --This will return all ID’s with the last name of “Smith” and the 

first name of “Carol”.  

 

To clear a field when searching, select Query/Enter. 
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Choose GUIALTI to search by Alternate ID (Social Security Number)  
The first field is the social security number. Enter the social security number without 

hyphens.  

Search or execute this query by:  

 1. Press F8  

 2. From the toolbar Execute/Query  

 3. Select the Execute Query icon between the question mark and X on the toolbar.  

 

Enter part of the social security number to search using the wildcard %. For example, 

123% 

 
Search by Partial Name  
This is the Preferred method as there is less likelihood of missing an already existing 

record. Perform partial name search following any search by SSN that does not yield 

results. From the Key block of a form, select backspace key to clear field. Another way to 

clear a field is to select Item/Clear from the tool bar.  

Tab to the name field, enter a partial name with the wildcard %. Enter the first three or 

four letters of the last name with %, a comma, and a space. Then enter the first letter of 

the first name with a %. Enter. If you use the full last name and the first letter of the first 

name and this returns no results, re-search using less specific criteria.  

If one match is found, the ID and name are returned to the form.  

If more than one match is found, the ID and Name Extended Search window appears
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Exercises to practice Navigation and Searching for Student Information  
To use the menus described below, type the letters listed under the Menu column in the Direct Access box 

on the first screen of Banner. Terms are coded as follows: 200810 = Spring 2008; 200850 = Summer 2008; 

200880 = Fall 2008  

 
If you don’t know the student’s M#, click on the ID button and the Person Search Form will appear on the 

screen. Tab over to the Last Name column. Key in the student’s last name, Tab and key in the student’s 

first name (if you know it) or part of it. For example, Smith, Jo%. The % sign is a wildcard for searching in 

Banner Then press the F8 key. If several names appear, arrow down to the correct one, and click on the 

Select button at the bottom of the screen.  

 

Information 
Needed  

Menu  Instructions  

Academic History  SHACRSE  Enter T#, and key in term (for example, 

200810) or leave term blank. Next Block (or 
Ctrl+Page Down). Rollback (or Shift+[F7]) to 

enter another name. For term 200810 or 
200850, IP grade means student is enrolled (In 

Progress).  

GPA  SHATERM  Enter T# and level, UG for undergraduate or GR 
for graduate, and leave Term blank to see a 

cumulative academic history record; Next Block 

(or Ctrl+Page Down) to see overall GPA. 
Rollback (or Shift+[F7]) to enter another name.  

Admissions 
Information  

SAAADMS  Enter T#, Next Block (or Ctrl+Page Down). 
You’ll see all the activity in the student’s 

admissions file: program, entrance status, etc. 
Rollback (or Shift+[F7]) to enter another name.  

General Student 
Information  

SGASTDN  Enter T#, Next Block (or Ctrl+Page Down). 
You’ll see all the activity in the student’s record: 

program, classification, residency, veteran 

information, academic standing, graduation 
status, etc. Rollback (or Shift+[F7]) to enter 

another name.  

Student Address  SPAIDEN  Enter T#, Next Block (or Ctrl+Page Down). To 
see the student’s current address and telephone 

number, click on the Address button at the 
bottom of the screen. Rollback (or Shift+[F7]) 

to enter another name.  
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Prior College 
Information  

SOAPCOL  Enter T#, to see from where and if the 
student graduated, when, and if we have an 

official transcript on file. Rollback (or 
Shift+[F7]) to enter another name.  

High School 
Information  

SOAHSCH  Enter T#, Next Block (or Ctrl+Page Down) to 
see from where and if the student graduated, 

when, and if we have an official transcript on 
file. Rollback (or Shift+[F7]) to enter another 

name.  

Student Address  SPAIDEN  Enter T#, Next Block (or Ctrl+Page Down). To 
see the student’s current address and 

telephone number, click on the Address button 
at the bottom of the screen. Rollback (or 

Shift+[F7]) to enter another name.  

Registration by 
Term  

SFAREGQ  Enter term (for example, 200780) and M#, 
Next Block (or Ctrl+Page Down). Rollback (or 

Shift+[F7]) to enter another name.  

Transfer Credit 

Information  

SHATRNS  Enter T#. Enter Transfer Inst. No. 01., 

Attendance Period No. 01, Next Block (or 
Ctrl+Page Down) until you see screen with 

transfer credits listed. Rollback (or Shift+[F7]) 
to enter another name.  

Prescribed Course 
& Academic 
Deficiencies  

SZAADEF  Enter T#, Next Block (or Ctrl+Page Down), 
view academic deficiencies (A89) requirements 
and prescribed course requirements.  

PIN/code entered 
to allow student 

registration on 
myTSU  

SPAAPIN  Enter term (200780) then tab. Enter T#, 
enter. Next Block (or Ctrl+Page Down).  

Registration History  SFARHST  Enter T#, Next Block (or Ctrl+Page Down). 
Shows term, course, and grade. Rollback (or 

Shift+[F7]) to enter another name.  

General Student 
Summary  

SGASTDQ  Enter T#, Next Block (or Ctrl+Page Down) to 
view academic standing and progress 

evaluation by term, curricula summary, and 
field of study summary.  

Issue Permits & 
Overrides  

SFASRPO  Enter T#, enter. Enter term (200780) then 
tab. Next Block (or Ctrl+Page Down).  
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COURSE SCHEDULING 

 

 
The goal of this section is to provide you with the knowledge and practice to setup and 

maintain a schedule of classes. 

 

The Schedule Form (SSASECT) is used to build and maintain the schedule of classes 

according to the definitions and restrictions created in the Course Catalog.  A course 

catalog record must exist prior to the creation of sections for a particular course. 
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Banner Form (SSASECT) 

 
Follow these steps to complete the process of scheduling a section of a course. 

 

Step                         Action 

1 Access the Schedule Form (SSASECT) 

2 Enter the term in the Term field 

3 Enter ADD in the CRN field 

4 Perform a Next Block function 

5 Enter the Discipline (i.e. ENGL) hit enter 

6 Enter the Course Number, hit enter (the title of the course will populate) 

7 Continue by entering the following information 

 

Field Enter Value 

Section 01 01 

Campus 45M Main 

Status A Active 

Schedule Type LEC Lecture 

Part of Term 1 1 Must hit enter and SAVE 
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To assign Course Limit: click Section Enrollment Information tab and enter enrollment 

limit in the Enrollment Detail block.  Click the Save icon.  Note:  A CRN has been 

assigned to the sections and you are returned to the form. 

Banner Form 
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Assigning a Meeting Time and Instructor: 

 

To assign meeting times: click Meeting Times and Instructor tab. 

 

From the Meeting times detail section 

1.  Hit enter/tab twice to populate the Meeting Type, Start Date  and End Date 

2. Check meeting days 

3. Enter Start Time and End Time (Time must be enter in military time) 

4. Click the Save ion. 

 

To assign instructors next block to the instructor detail block 

1. Enter instructors T# and click enter 

2. Click Save (if you receive a conflict error, you must populate the override 

indicator) 

NOTE:  You must have a meeting time to assign an instructor. 

              If the meeting time is TBA populate the Meeting Type, Start Date and End  

              Date. 
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If you do not have the T# you must use the Faculty/Advisor Query Form, to locate the 

faculty member created in the Faculty Load module.  An instructor cannot be assigned 

to a section of a course until HR has assigned in Banner. 

 

Locating an Instructor 

1. Click on Lov button under ID in the Instructor session 

2. Click the query icon 

3. Scroll listing  to locate instructor 

4. Double click on instructor and it will populate the instructor detail block 

5. Click Save icon. 

6. Roll Back 
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The Schedule Section Query Form 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 29 

 

24 HOUR CLOCK MILITARY TIME 

Banner requires the use of a 24-hour clock to input class meeting times.  When the class 

schedule information is displayed online, via myTU, Banner converts the 24-clock time 

into 12-hour (am/pm) standard clock times. 

 

1:00pm     =    13:00                                  7:00pm     =    19:00 

2:00pm     =    14:00                                  8::00pm   =     20:00 

3:00pm     =    15:00                                  9:00pm     =    21:00 

4:00pm     =    16:00                                 10:00pm    =    22:00 

5:00pm     =    17:00                                 11:00pm    =    23:00 

6:00pm     =    18:00                                 12:00am    =    24:00 
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Main Campus Buildings 

 
 

 

 

 

 

 

 

 


